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ELECTRONIC FORMS SYSTEM (EFS)
LM-2

EFS is a web-based system for completing and filing Form
LM-2 Labor Organization Annual Report.

This tutorial demonstrates basic features and functionality of
the EFS LM-2 form. It does not contain instructions for what
Information should be provided on your report.

You can download a complete set of LM-2 Instructions from:

http://www.dol.gov/olms/regs/compliance/EFS/EFShelp.htm




System Requirements and Settings

To access and use the EFS, OLMS recommends you use one of
the following browsers:

*Microsoft Internet Explorer — Version 6 or higher

*Firefox — Version 3 or higher

Screen Resolution:

For optimal viewing, set your screen resolution to 1280 x 1024 or
greater. OLMS recommends that at a minimum you set your screen
resolution to 1152 x 864 to avoid horizontal scrolling.
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Accessing the System

Log into EFS using your user ID and password and the filing union’s six digit
file number and unique union PIN.

(Please see the tutorial on how to register if you do not have a user ID or a
union PIN.)

Subscribe to E—ma|l Updates ONIDOL @ EsA  Advanced Search
\ UNITED STATES Fretinool Jaean]
DEPARTMENT OF LABOR AtoZIndex SiteMap FAQs DOLForms About DOL ContactUs
DOL Home = EFS
Electronic Forms System B B et size

OLIMS Help

Welcome to the Office of Labor Management Standards

Electronic Forms System (EFS)
Click here for a brief wsowinkof shesysiam s s s s s s s s s nnn,
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Registration: Sign in:
Register for an EFS User account and password - Click here.
) ) ) ) User ID Iwillifo
Obtain a Union Pin - Click here.
) ) ) ) User Password oy

If you wish to edit yvour account information - Click here.
File Mumber 44 - |bbb
Union PIN 15193

Forgot your password? Forgot your User ID?

Frequently Asked Questions | Freedom of Information Act | Privacy & Security Statement | Disclaimers | Customer Survey | Important Web Site Notices




=]
-
2
o
=
Q
o
<

Select one of the options displayed on the screen.

(Please note that the only forms that you can amend in EFS are ones that were

filed using EFS.)

New Form

What would you like to do?
__f___CDntinue to work on forms in progress

5' Start a new form
" amend an already submitted form

The Electronic Forms Systern customizes the LM-2 with your Union's

irfor mation,

Fiscal Year Selected

|2EI1EI 'l
ILM-E 'l

Form Selected

Period Covered

Beqgin Date IEIUEIUEEHEI
End Date |1 22man

GetForm |

at

4"

L

at

Logout

= You must change :
. the “period
* covered” dates
before obtaining
the form




LM-2 Page 1

The EFS form looks similar to the old Adobe form. Your union information is
pre-filled, as are the start-of-period figures on Statement A.
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PAGE 1 i i i
Sav® Im[ggg' . Add Attachments — Validate Submit Help Print
PAGE 2 [ ] L 4
] e
STMT A [ ]
- FORY LM-2 LABOR ORGANIZATION ANNUAL REPORT o
STMT B 1= LEparimet ar Labor ‘. Office of Management and
Office of Labor-Management . Budget
SCH 1 Standarﬁls MUST BE USED BY LAQ@Q CORGANIZATIONS WITH $250,000 OR MORE IN TOTAL AMMNUAL RECEIFTS AND Mo 1213-0188
Washington, GiC 20210 4, LABOR ORGANIZATIONS IN TRUSTEESHIP Expires: 09-11-2011
- SCH 2 L ] L 4
SCH3 This report is man!ator\,r under P.L. 86-257, as amended, Failure t®gomply may result in criminal prosecution, fines, or civil penalties as provided by 29 U.5.C, 439 or 440
O u READ THE INSTRUCTIOME CAREFULLY BEFORE PREPARING THIS REPORT.
— SCH4 . 2 PERIOD C&ERED 3.@;) AIE-WENDED - If this is an amended report, r
SCH S - S check here:
For Offical Use Ony 4. FILE NUMBER QDAY TEAR () HARDSHIP - If filing under the hardshin 0
5CH6 E : 544-R6h From 01012010 .0. procedures, check here:
m SCHT ' Through 12/31/2010 0.; Lc;r';I?RMINAL - If This is a terminal report, check r
= stns 4, AFFILIATION OR ORGANIZATION NAME 8. MAILING ADDRESS (Type or print in capital letters)
Q SCH9 FACTORY WORKERS Firat Nams Last Nams
O SCH 10 S. DESIGNATION (Local, Lodge, etc.) 6. DESIGMATION JOHN ShAITH
MUMBER —
SCH11 P.0 Box - Building and Room Mumber
—
- StH12 ROOM 1A
7. UNIT WNAME (if an
(Q SCH13 Lif ary) Number and Street
PITTSEURGH REGION
SUMMARY 1234 MAIN STREET
O SCH 14 City
< ot 15 Q. Are your organization's records kept at its mailing ves O FITTSBURGH
5 (TR g p p
address? (If "No," provide address in Item 63.) Mo O Ctate 2P Code + 4
SCH16 [Pa =] 54321-1234
5CH 17 - . - - - - -
Each of the undersigned, duly authorized officers of the abowve labor organization, declares, under penalty of perjury and other applicable penalties of law, that all of the
SCH18 infarration subrnitted in this report {including infarrmation contained in any accompanying docurnents) has been examined by the signatary and is, to the best of the
undersigned individual's knowledge and belief, true, correct and complete {See Section ¥ on penalties in the instructions.)
SCH19
70. SIGNED: I |PRESIDENT 71. SIGNED: I |TRE£‘«SURER
SCH 20
(If other title, see instructions) (If ather title, see instructions)
ADDNL INFO Telephone l— Telephone I—
YALIDATION Date: I Mumber: Date: I Humber:
SUMMARY

Add Additional Sighatures




Navigation

You can easily move through the form by using the navigation links to the
left to go directly to a page or by scrolling through pages using the arrows
at the top. #-...,
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PAGE 1 Save Import Add Attachments - Validate Submit Help Print
PAGE 2
STMT A
FORM LM-2 LABOR ORGANIZATION ANNUAL REPORT Form Approved
U.5, Department of Labor s
STMT B o Office of Management and
Office of Labor-Management Budget
[ ] SCH 1 Standards MUST BE USED BY LABCR ORGANIZATIONS WITH $250,000 OR MORE IMN TOTAL AMMUAL RECEIPTS AND Mo 1213-0188
Washingtan, DC 20210 LABOR ORGANIZATIONS IN TRUSTEESHIP Expires: 09-11-2011
O SCH2 '
[r— SCH3 This report is mandatory under P.L, 86-257, as amended, Failure to comply may result in criminal prosecution, fines, or civil penalties as provided by 29 U.5.C, 439 or 440
READ THE INSTRUCTIONS CAREFULLY BEFORE PREPARIMG THIS REFORT.
3 SCH4 2. PERIOD COVERED 3.(a) AMENDED - If this is an amended report, -
SCH 5 - check here:
W Far Official Use Only 11, FILE NUMBER MO DAY YEAR {b) HARDSHIP - If filing under the hardshin 0
SCHE E B44-RER From 014012010 procedures, check here:
- i} L .
SCHT Through 12/31/2010 Lc;r';I?RMINAL If This is a terminal report, check r
Q stHe 4. AFFILIATION OR ORGAMNIZATION MAME 8. MAILING ADDRESS (Type or print in capital letters)
O SCHA FACTORY WORKERS First Mame Last Mame
— SCH 10 S. DESIGNATION (Local, Lodge, etc.) 6. DESIGMATION JOHN ShAITH
MUMBER —
- SCH11 P.0 Box - Building and Room Mumber
o 7. UNIT NAME (if ROOM 1A
. if an
o SCH13 ( ) Mumber and Street
PITTSEURGH REGION
< SUMMARY 1234 MAIN STREET
SCH 14 City
ot 15 Q. Are your organization's records kept at its mailing ves O FITTSBURGH
5 (TR g p p
address? (If "No," provide address in Item 63.) Mo O Ctate 2P Code + 4
SCH16 [Pa =] 54321-1234
SCH17T K . X L R R .
Each of the undersigned, duly authorized officers of the abowve labor organization, declares, under penalty of perjury and other applicable penalties of law, that all of the
SCH18 infarration subrnitted in this report {including infarrmation contained in any accompanying docurnents) has been examined by the signatary and is, to the best of the
undersigned individual's knowledge and belief, true, correct and complete {See Section ¥ on penalties in the instructions.)
SCH19
70. SIGNED: I |PRESIDENT 71. SIGNED: I |TRE£‘«SURER
SCH 20
(If other title, see instructions) (If ather title, see instructions)
ADDNL INFO Telephone l— Telephone I—
YALIDATION Date: I Mumber: Date: I Humber:
SUMMARY

Add Additional Sighatures




Navigation

There are links throughout the form to take to you to other
parts of the form.

For example, the statement totals have links to their
corresponding schedules.

% ASSETS ““Sr:]:SrencéLéhra Start of RerEnE;ting Period ‘ End of Rep{n:é'r:lting Period
— 22, Cash “3 |

3 23, &ccounts Receivable 1 %0
Sn 24, Loans Receivable 2 0
Q 25, .5, Treasury Securities $0

2 26, Investments 5 $0
(-Q 27, Fixed &ssets [=} %0
o 28, Other assets 7 %0
< 29, TOTAL ASSETS $150.000 £0




Getting Help Within the Form

The form has several built-in help functions.

Mouse-over text that displays information on what to report or how to enter

data into a field is available on many items.
:t:‘,
] *
*
= 10, During the reporting period did the . "‘ *
O labor organization create or participate in % . ¢ g F
— the administration of a trust or other fund 4 ., vee, U
or organization, as defined in the L T ’@
3 instructions, whil"a krust in which a labor organization is inkerested" i .’o
members or theidefined in Section 31 of the LMRDWE (29 1.5.C, 402{59‘.35 LR
U) krust or other Fund or organization (1) which was created or *
3 11. During the rqestablished by a labor organization, or one or mare of thks S ’o‘
Q labor organizatig trustees or one or more members of the governing body ofs [ = ‘Y
committes (PAC which is selected or appointed by a labor arganization, and % (&) ‘e
O (21 a ptimary purpose of which is to provide benefits For the | % ’0‘
. i ) ek . .
-— 12, During the rLrﬂ?_,r?Eﬁr.iDLiﬁlshl?bf.run[??ﬂlzatmn or their beneficiaries, ., .
ol e B R e e R e B . .
(Q % ".
o !:II' Iy pramces;pruceuures fsred nthe e Lo =
instructions? % ‘e,
< % *e
19, What is the date of the Iahﬁs‘urganizatinn's ‘s, 1202010
next regular election of officers? s, 4
] * MM
20 How many members did the I:uhm;
*
. I3
20, How many members did the labar X
organization have at the end of the reporting N
period?(Total from the 'Members' row of ‘<
Schedule 13) |The syskem enters the Total from Schedule 13|
Lo e B 1 A P Y S [ S e e S P LR SE P S T T = I b B sl = o S




Getting Help Within the Form
Click the Help link at the top of each page to open the form

EFS Home > LM2 Home Logout
Electronic Fili
ectronic Filing System “‘...
*
PAGE 1 . & . .
Save & Calculate Import Add Attachments -.‘ — Validate : Help » Print
PAGE 2 Y
*
. * (544 -
STMT A COMPLETE ITEMS 10 THROUGH 21 Aggus® FILE MUMBER.:544-555
STMT B
. File Edit View Faworites Tools Help
SCH 1 10. During the repo - —
labor arganization o () Back = 00 - (2] 2] | - Search - Favaorites 4% =T o
- SCHZ the administration . .
SCH3 ar organization, as Address http: v, dol. gov) olms/regsfcompliance/ef sfLMZpagez . htm j a Go | Links %Convert
instructions, which
— SCH 4 members or their b
SCH 5 11. During the repo UNITED STATES Sub E-rmail U o pll ®OLMs A h
|abor organization Enter E-mail Add cusscriee [ Find It n DOL
3 s commite (F40) DEPARTMENT OF LABOR CETIEEEN EC= [ ==
m SCH7 . AtoZ | SiteMap | FAQs | Forms | About DOL | Contact Us | Espaiiol
12, During the repo
= SCH & labor arganization t Office of Labor-Management Standards p=3 Print This Page Iy Text Size | ) E-mai This Pag
of its books and rec : = L+ .
Q SCHY accountant or by a Dol Home > OLMS = LM-2 Instructions
SCH 10 auditor/represental
. Compliance Assistance |
O o 13. During the repo Office of Labor-Management Standards (OLMS)
I labor arganization ¢ Regulatory Library
- SCH 12 shortage of funds c S . = Page 1 Statement & =
"Yas" ews Room
SCH 13 (Answer "fes" ever INFORMATION ITEMS 10-21
repayment or recov About OLMS
SUMMARY . | Answer Iterns 10 through 21 as instructed. Select the appropriate box for those guestions requiring a "Yes" or "No" answer; do not
o 14. WWhat is the ma: Contact Us leave both boxes blank, Enter a single "0" in the boxes for items requiring a number or dollar amount if there is nothing to report,
SCH 14 recoverable under t
SCH 15 fidelity bond for a Ic 10. TRUSTS OR FUNDS — Answer "Yes" to Item 10, if the labor organization has an interest in a trust as defined in 29 U.5.C. 402()
officer, employee or (see Section X of the Form LM-2 Instructions ), Provide in Iterm 69 (Additional Information) the full narme, address, and purpose of each
SCH 16 arganization wha h trust, Also indlude in Item 69 the fiscal year ending date for any trust for which a Farm T-1 is filed if the trust’s fiscal year is different fram
_ that of the labor organization. If no Form T-1 is required to be filed on the trust because (1) the trust had annual receipts of less than
SCH17 15. During the repo $250,000 during the trust’s most recent fiscal year or (2) the labor organization’s financial contribution to the trust or the contribution
labor arganization ¢ made on the labor organization’s behalf, or as a result of a negotiated agreement to which the labor organization is a party, is less than
SCH 18 any assets in any m $10,000, the labor organization should also report the amount of the contribution in Item 69 and, if the contribution was made by the
SCH 19 purchase or sale? labor organization itself, in the appropriate dishursernent itern in Staternent B, Additionally, if no Form T-1 s fled because financial
information is aready avallable as a result of the disclosure requirernents of another Federal statute, list the name of any government
SCH 20 agency, such as the Employes Benefits Security Administration (EBSA) of the Departrnent of Labor, with which the trust files a publicly
available report, and the relevant file nurmber of the trust, or otherwise indicate where the relevant report may be viewed, See
ADDNL INFO I the answer o any of Instructions for Form T-1, Trust Annual Report, for guidance on reporting the assets, liabilities, receipts, disbursements, and other
VALIDATION \If the answer to any of infarmation about these entities.



Menu Items

The menu across the top of the form contains the following items:

Save & Calculate Import Add Attachments -.."l — Validate Help Print

1. Save and Calculate — Click this item to save the current page and perform all mathematical
calculations. Calculations are not performed automatically because doing so would
dramatically reduce the speed of the application. It is important to click Save and Calculate at
regular intervals when entering data in the form. If you do not save, you will be prompted to do
so when you navigate away from a page.

2. Import — Click this item to open the Import page for importing schedule data. You can import
into any schedule by clicking this link. You do not need to have a schedule open to import data
for its completion.

3. Add Attachments — Click this item to open the Add Attachments page where supplemental
information (like a constitution and bylaws or audit report) can be uploaded. The uploaded
data can then be submitted with the form.

4. Validate — Click this item to run the form validation routine, which checks the form for missing
data. Each page has its own set of validations, and you will be prompted to fix these items
before leaving the page if you wish. All validations must be satisfied before the form can be
signed and submitted.

5. Help — Click this item to take you to page-specific instructions for completing the form. You
can navigate through the instructions page by page, or download/print a copy from our

website at: http://www.dol.gov/olms/regs/compliance/EFS/EFShelp.htm.

6. Print — Click this item to open a facsimile of the electronically completed LM-2. You can save
a copy of this report to your computer and share it with others who may need to prepare or
review the document. You may save a copy of the final signed report prior to submission.
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Additional Information

Throughout the form, there are
places where the system will
prompt you to enter additional
information. You have the option
to check a box to enter the
information later, and the
Additional Information prompt
will remain red to remind you
that you will need to enter
additional information before
submitting your report.

To go back and enter the
additional information, double-
click on the Al icon and enter the
additional information. The
prompt will turn green, indicating
that additional information has
been entered.

The Additional Information
Summary can be found in the
left navigation pane.

Additional Information - Trust or Fund

Please provide the full name, address, and purpose of each trust, Also include the fiscal year ending
date for any trust for which a Form T-1 is filed if the trust” s fiscal year is different from that of the labor
organization. If no form T-1 is required to be filed on the trust, the labor organization should also report
amount of contribution and, if the contribution was made by the labor organization itself, in appropriate
disbursement itern in statement B. additionally if no form T-1 is filed because financial information is
already available as result of disclosure requirements of another Federal statute, list the name of any
government agency with which the trust files publicly available report, and the relevant file number of
the trust, ar otherwise indicate where relevant report may be viewed.

Please Mote: Once you begin entering information, you must press SAVE or ENTER LATER buttan to exit the
Additional Information data entry process.

FUC, INC =]
555 Main Street

es @ g geesassss  Additional Information entered

Mo O

es

o Additional Information needs to

o
r ‘lllllll

be entered



Additional Information

SCH 18
SCH 19

scrizq "Click the ADDNL INFO link in the left navigation pane
.;‘;;Tmm;;':.‘ to display the Additional Information Summary page.

L 4 .
vAEATION
SUMMARY
To enter any other
additional information
required by the form ", gunmnEa,
. . . ..A " .Q
instructions, click the K3 *
5 & Calculat Import Add : : lidat: G al Inf ati o Print
aue alculate mpol General |nf0rmatlon ||nk al e l“ EReral intornmanan .. Hrint
69.ADDITIONAL INFORMATION SUMMARY ’... ““‘ FILE MUMBER:544-555
Emmnm

1Question 10; FWC, IMC
555 Main Street
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: . 69.ADDITIONAL INFORMATION SUMMARY
To go to the item, click

on the blue additional ~ [===========9 1Question 10: FWC, INC
. . 555 Main Street
information text.
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Entering Data into the Form

There are two ways to enter schedule data in the form: manually
entering data and importing data.

Manual entry may require you to add more rows to a schedule. A
blank schedule in EFS has 10 rows. If you need more than 10 rows,
click the “Add” button located at the top of each schedule. This will
add an additional 10 rows. -..,.

4,
..... ..
Sawve & Calculate Import Add Attachments _Z';——, A Validate Help Print
“‘.-llllll.f...
SCHEDULE 1 - ACCOUNTS RECEIVABLE AGING SCHEDULE .‘ Add Accounts Receivable ¥4 FILE NUMBER.:544-555
Entity or In(d';x)ridual Mame Total Accuu(nat) Receivable '9%53%?;3. —_— jr . "'1&30;: 83;5 quu:_f;ct:igiclceuunt
(cl (o) (E)
1
2
3
4
=]
a]
7
a8
=]
10
|Tota| of all itemized accounts receivable I I I I

|TDtE|| from all other accounts receivable | | | |

JTDtaIs (Total of Column(B) will be automatically i I i '
entered in Itern 23, Colurmn (B)) l l l l




Entering Data into the Form

After entering data in a schedule, click the Save & Calculate link to
perform calculations.

“‘-IIII.... A“‘
;. Save & Calculate ’: Import Add Attachments - validate Help Print
SCHEDUI:E.f . ACCGL‘H\TT‘S RECEI¥YABLE AGING SCHEDULE Add Accounts Receivable FILE NUMBER :544-555
Entity or Individual Name Total Account Receivable 9%—;&0[)%?5 136?;{: 33;5 Liquigl:ci::igjjclceuunt
(c) (D} (E)
1 K. Thomasg| $1.000
2
3
- 4
@ :
I G
3 7
=]
w g
- 10
Q |Total of all itemized accounts receivable I I I I
O |T0tal from all other accounts receivable | | | |
—— otals (Total of Column(B) will be automatically i f f f
- J;ntered in Item 23, Colurmn (B)) I I I I
@ | iy wey |
O 1 K Thamas $1.000
2
< :
A
5
=]

The calculated totals will display in the Totals fields:

10
|TDtaI of all itemized accounts receivable $1.000 l_

ITDtaI from all other accounts receivable |

JTDtaIS {(Taotal of Column(B) will be automatically %1000 "
entered in Item 23, Column (B)) ‘
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Entering Data into the Form

The schedule data carries forward to the statements,,

4
O....
'..
....
...
Schedule Start of Reporting Period End DT'RQpDrting Period
ASS5ETS

Number Ly tem
22, Cash | ennene, ]
23, Accounts Receivable 1 | :’ $1.000
24, Loans Receivable 2 | R
25, .5, Treasury Securities $0
26, Investments 5 | $0
27, Fixed Assets [=} | $0
28, Other Assets 7 | i
29, TOTAL ASSETS $0 I $1.000

an®
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Importing Data into the Form

To import data into the form, click the Import link on the top menu
bal' ................................. e b

.....

Select the schedule from the dropdown menu. Schedules 14-19
require two import files: one for master records and one for detalil
records.

IMPORT SCHEDULES

Select Source Of Impork Data ICS‘\-’ "I

=Y =Nl li=tu =Y BI=W - checlule 11 - All Officers and Dishursements
Select Import File | Browse... |
Select Detail Import File I Browse... |
Skt |

A file in CVS or XML format is required to import data. These are the
same formats used in the previous Form LM-2 system. For detailed
Information on creating import files, download the Data Specification

Document found on the OLMS website at:;
http://www.dol.qgov/olms/regs/compliance/dsd.htm




Importing Data into the Form

Click Browse to select the file to be imported.

IMPORT SCHEDLULES

Select Source Of Import Data ICSV vI
Select Schedule

Select Import File | Browse... |

SelsctDetai Import il 21
= Laak, ir: Ilﬂ C5W Sample Files Sarmple 4 j o= & E-

il Mz 51 B Mz_514_Detail
LMz sz EL]LMz_514_Master
Sh|LMz_53 Eh]LMz_515_Detail
4Ll Mz_54 Bz _s515_Master
LMz s5_other  BLLMz_S16_Detai
—a|LMZ_55_Security IgLMZ_S1(-Zu_r\'1.ilster
Ll mz_s6_Buildng  EhjLMz_S17_Detai
Bz _517_Master
B mz_s18_petail
Eh]LMz_515_Master
B Lmz_s519_Detail
B LMz _519_Master
Bz _szn

Schedule 11 - All Officers and Dishursements
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File name: ILM 2 511100 j Open I
Files of type: [ &0 Filess ) = Cancel |
P
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Importing Data into the Form

Click Submit to import the data file. If the import is successful,
the data will display in the schedule. Click the Save &
Calculate link before moving to the next schedule.

Note:

Large import files will import quickly, but saving the imported
files to the database will take some time. An hourglass icon or
the “Please wait” indicator bar shown below will let you know
the system is working to save the data. Please be patient when
working with large amounts of data.

10 Schedule 17 [ Schedule 18

Lobbying ?  Contributions ®  General Overhea

FPleaze wait....

0
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Importing Data into the Form

If any formatting problems are found in the data file during
Import, a list of errors needing correction will appear.

The import operation failed to complete. Import file has following errars.,

Source Of Import
Data:

Selected Schedule: officerDishursements

C5v

Import File: \; v5 511 ERROR.CSV

Errorf¥Warning Messages

Y:\E.LORS UATA\EFS UAT\GROUP 4%\CSVY SAMPLE FILES SAMPLE 4 2-16-10Y\CSV SAMPLE FILES SAMPLE 4

Frocessed 99 input lines.
2 errors, 0 warnings.

L4
L4
L4
L4
4
L4
L4
L4
L4
L4
L4
4
L4
L4
L4
4
L4
L4
L4
L4
4
L4
4

4

EEEENN
“‘-- "re,
. >

Error:line Z:column5:Field 'status' is not a valid officer3tatus.
Error:line 7:columni:The required field 'last' was not provided.

[

You can save and print the error report
to help with the correction process.

All errors must be corrected before the
file can be imported.

The Data Specification Document
located on the OLMS website gives
detailed guidance on the required data

schema.
B

@ %
i .

[ S an el eyt |

., B Save Frint | “-

.
"*saanunnnt®
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Attachments: Attaching Supplemental Data

As with the previous forms system, EFS allows you to attach
data, such as constitutions and bylaws, that may be required
to be submitted with the report.

To begin the process of adding an attachment, click the Add
Attachments link on the top menu bar.

Add Attachments

Note: While the system does not prevent them from being
uploaded, certain file formats cannot be read by our
system. The following file formats can be read:

*Adobe PDF

*Microsoft Word

*Microsoft Excel

*Rich Text Format

*HTML

*Standard Picture formats JPEG, BMP, GIF
*Text files



Attachments: Attaching Supplemental Data

Save & Calculate Import Add Attachments -.."l — Validate
ATTACHMENTS
Select Type of Attachment v
Select File — .
Constitution and/or Bylaws
Audit Report
Other
Additional Information
SR LEY )N
[ ] * *
(@) Attached Files N .
* *
‘.J;_]... Attachment Type RETTHPTL A
* *
3 -: [ ] EF=%Schedule.pdf Bylaws and Other Attachments ..‘
L4
S’) ‘0....‘$‘ .Q.
&
Q k‘ o
. &
* &
O *e RS
— L R4
- * &
* &
(o) “ ;
‘Q .0
@) % o
* &
* *
< 0‘ *
. L2
. &
. L4
. &
- &
* &
* &
* &
* &
., R

Select the type of attachment you want to upload. Reviewers can view
attachments by selecting the check box to the left of the attachment
name and clicking the open link.




Validation

There are two types of validations built into the form to help ensure that the
correct data is being entered into the form: Page Level Validations and
Form Level Validations.

Page Level Validations occur before you navigate away from a page. A
pop up message will alert you of items that must be corrected before the

o form can be signed and submitted.

3 FMesaage from webpage -\ =

w HO

= P The items below Failed to pass the validation. Do wou wank to correct them now?

Q (Click "OK" ko correct them now or click "Cancel” ta correck therm later, )

2 Pagez:Item 14 musk be completed with the maximum dollar armount recoverable under vour union's Fidelity bond;

(Q (0] 4 ] [ Cancel ]
@)
<

If you click OK you can correct the item before leaving the page.

If you click Cancel, you can correct the item later. You will be prompted to
make the correction during form validation.
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Validation

Form Level Validations occur as a final check before the form can be
submitted. You must click the Validate link on the top menu bar.

stem

Save & Calculate Import Add Attachments -.‘ Validate Print

FILE NUMEBER:344-555

VALIDATION SUMMARY PAGE

1. Page2:Item 14 must be completed with the maximum daollar amount recoverable under your union's fidelity bond
2. StatementB:Item 36 must be completed with 3 number or 0
3. StatementB:Item 37 must be completed with a number or 0
4, StatementB:Item 38 must be completed with a number or 0
5. StatementB:Item 39 must be completed with a number or 0
6. StatementB:Item 40 must be completed with 3 number or 0
7. StatementB:Item 41 must be completed with a number or 0
8. StatementB:Item 42 must be completed with a number or 0
9, StatementB:Item 46 must be completed with 3 number or 0
10. StatementB:Ikem 47 must be completed with a number ar 0
11. StatementB:Item 56 must be completed with a number or 0
12. StatementB:Item 57 must be completed with a number or 0
13. StatementB:Item 58 must be completed with a number or 0
14. StatementB:Item 59 must be completed with a number ar 0
15. StatementB:Item 63 must be completed with a number or 0

< ?

The system will open the Validation Summary Page containing a list of
items that must be corrected.

You can click on each item and be taken to the page where the item can
be corrected. For more information on what should be provided for these
items, consult the form instructions.



Signing the Form

Once all of the validation items have been corrected, the form is ready to
be signed.

Message from webpage

This form has passed the wvalidation check. Yalidations only check ko make sure data has been entered propetly in the Form, but there could still be reporting errors in the
I form. Please review the LM-2 instructions to make sure this form has been Filled out according to the requirements.,

Please click on a signature field to sign.

The signature blocks will turn red, indicating the form can be signed.

Each of the undersigned, duly authorized officers of the above labor organization, declares, under penalty of perjury and other applicable penalties of law, that all of the
informaticn submitted in this report (including information contained in any accompanying documents) has been examined by the signatoery and is, to the best of the
undersigned individual's knowledge and belief, true, correct and complete (See Section Vv on penalties in the instructions.)

70. SIGNED: Click Here to Sign PRESIDENT 71. SIGMED: Click Here to Sign TREASURER

(If other title, see instructions) (If other title, see instructions)

. Telephone Ii . Telephone Ii
Date: | Date: | Mumber:

Number:
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Note: All officers who must sign the form must have established user
accounts and must log into EFS with their account information to
sign the form.




Signing the Form

You must re-enter your password to ‘sign’ the form. By doing
S0, you are legally attesting that you are the person identified
by name in the signature block and a duly authorized officer
of the union.

President’s Signature
By entering my name and password below, I attest that I am John 1 Smith, a duly authorized officer
of the abowve labor organization, and declare, under penalty of perjury and other applicable penalties of
law, that all of the information submitted in this report {including the information contained in any
attached documents) has been examined by me and is, to the best of my knowledge and belief, true,
correct, and complete.

First Name John
Middle Initial

Last Name Smith
Date 08/16/2010

Password sssssnes
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Phone Mumber 70355571272
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Signing the Form

A minimum of two signatures are required to submit the report. If there is a
need to apply more signatures on the form, click the Add Additional
Signatures link below the signature blocks to add two additional signature
bIOCkS. ....".n

llllllllllllllll
L

*

70. SIGMED: |Jth J Smith PRESIDEMNT
(If ather title, see instructions)
Date: [08/16/2010 Teephone 703-555-1212

Once the report has been signed, if any changes are made to any fields
on the form, the signatures will be removed and the form must be
validated and signed again.



Save a Sighed Copy

Click the Print item and click File=> Save As to save a signed copy of the
report as a PDF to your computer. Do this before submitting the report.

raras FORM LM-2 LABOR ORGANIZATION ANNUAL Dh:f;fenrafgf
nagery” g , ",-.E.E_: Dg.
* | Save a Copy...
T | Hby 291
Save in: | [ Downloads w O * -
ded re
] A
O Lkﬁ EIT - 2010 LM-2 Factory Workers,pdf = hard:
— by Recent Adobe Acrobat 7.0 Docunent |
— Diocuments o oy 55 KB al renc
3 AGAN | et
ERS E%
m al, Lo —
- Dezktop
O 10N &,
— ._’_/ —
p 1aniz [willifa’s
(Q _ Diocuments
O il [ 4
< INF( :_!J nform
hwaillifo on
ESOLAMOR-F...
‘_:'] File name: 20710 Lk-2 Factary Sfaorkers. pdf ™
2 —
MyMetwork | Saveastyps: | Adobe PDF Files [* pdf] |

Note: You can obtain a copy of the submitted report from the Online Public
Disclosure site. Please see the next section for information on this.




Submitting the Form

Once the signatures have been applied, the form can be submitted.

Click the Submit button from the top menu bar. Once the form has been
processed (this may take a few minutes) a confirmation message will
display:

Submit

Logout
Your LM-2 Form has been successfully accepted for processing.
Your confirmation number is: 544555-400100-20100816120314
Please make a note of this number for your records.

To view your submitted LM-2 report, visit the OLMS Online Public Disclosure Room
QOLMS Online Public Disclosure Room link:
http: //www.dol.gov/olms/regs/compliance/rrlo/Imrda.htm
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You can print this message by going to File=> Print, or simply copy and
paste the text from the page into an email or word processing document.

You should now be able to view your submitted report in the Online Public
Disclosure Room, by using the link shown above.
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Troubleshooting

During peak filing periods, you may experience a slowdown in saving
and validating the report.

During these busy periods, you may see an error that looks like this:

O ool WESA Advanced Search

(T) UNITED STATES -

/ DEPARTMENT OF LABOR AtoZIndex SiteMap FAQs DOL Forms AboutDOL Contact Us

DOL Home » EFS
Electronic Forms System & B 7ot size

Logout

Error condition 2000 has occurred during submission processing. If this error continues to occur, please contact the QLMS Help Desk.
at 1-866-401-1109, Please select the Back link below to return to the LM2 home page.

Back

Please wait a few minutes and try again. However, if you continue to
experience the problem, please contact our technical support desk. See
the next page for information on how to get help.
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Getting Help

If you experience difficulty using EFS, please contact
OLMS Form Technical Support toll-free at:
1-866-401-1109

This PowerPoint presentation and other information regarding EFS can be

found on our website at the following URL.:
http://www.dol.gov/olms/regs/compliance/efs/efspreview.htm

If you have additional questions or comments please contact OLMS:
E-mail OLMS at olms-public@dol.gov
or contact your local OLMS District Office




